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Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Monospace font

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...

Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at http://documenta-
tion.softwareag.com. The site requires credentials for SoftwareAG's Product Support site Empower.
If you do not have Empower credentials, you must use the TECHcommunity website.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.comwith
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.
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You can find product information on the Software AG Empower Product Support website at ht-
tps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.asp and give us
a call.

Software AG TECHcommunity

You can finddocumentation and other technical information on the SoftwareAGTECHcommunity
website at http://techcommunity.softwareag.com. You can:

■ Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation" as an area of interest.

■ Access articles, code samples, demos, and tutorials.
■ Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

■ Link to external websites that discuss open standards and web technology.

Data Protection

SoftwareAGproducts provide functionalitywith respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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See Installing Natural Screen Tester from an Image File and also Prerequisites for information
on license keys, hardware and software requirements.

Typical Development Installation

The Software AG Installer offers typical development installations of products that enable you to
perform a certain task. When you select a typical development installation, the installer automat-
ically selects all products and components that make up that installation. You can select more
products or deselect products if desired. The typical development installation for this product is
called Natural Screen Tester.

To create production environments,workwith your administrators, SoftwareAGGlobal Consulting
Services, and best practices documentation.

Install Natural Screen Tester

Start the Installer and Provide General Information

Read the requirements in Using the Software AG Installer (for example, the requirement to create a
user account that has the proper privileges for Windows and that is non-root for UNIX). Follow
the instructions in that guide to start the installer and provide general information such as proxy
server, release to install, installation directory, and how to use the product selection tree.

Important: Unless otherwise stated for a specific product, do not install products from this
release into a Software AG directory that contains products from any other release. Unless
otherwise stated for a specific product, you cannot mix products from different releases in
the same installation directory; if you do so, you will experience problems or be unable to
access functionality.

On the product tree, choose Natural Screen Tester.

The installer then displays panels (GUI mode) or prompts (console mode) that ask for product
configuration information. Most are self-explanatory, so this section shows only the panels that
require explanation. The information and fields on the prompts is identical to the information and
fields on the panels.

Here is a list of default port numbers for Natural Screen Tester. These may be changed during
installation.

3323Server port
33443SSL port

Getting Started6

Installing and Uninstalling Natural Screen Tester



3380HTTP port
3323Admin port
3323AJP port

Important: Make sure all ports you specify on panels or in response to prompts are not
already being used by other products on yourmachine. The installer cannot detect whether
ports are in use when products are shut down, and the shutting down of products is a re-
quirement for running the installer. See list of default ports used by Software AG products
available in Empower.

Supply Product Configuration Information

If you are installing theNatural Screen Tester Server, the installer ask for information such as licence
file and ports.

Complete the Installation

Install Latest Fixes

Install the latest fixes on the products you installed. For instructions on using the Software AG
Update Manager, see Using the Software AG Update Manager. Each fix includes a readme file
that contains instructions on installing the fix.

Start the Natural Screen Tester

See First Steps for information on startingNatural Screen Tester and recording your first unit test.

Important: If any product you installed has a default password, you should change that
password as soon as possible. For instructions, see the product documentation.

Uninstall Natural Screen Tester

Follow the instructions in Using the Software AG Installer, with the additional guidelines below.

If you are going to uninstall Software AG Designer Eclipse, and you want to review or preserve
Eclipse installation information, do so before starting the uninstaller, because the uninstaller will
delete the entire Software AG Designer installation directory. Usercreated data that is stored in
other directories, such as your workspace, will remain untouched.

7Getting Started

Installing and Uninstalling Natural Screen Tester



8



3 Release Notes

■ What was New in Version 1.4 ............................................................................................................ 10
■ What was New in Version 1.3 ............................................................................................................ 10

9



There were no major changes in version 1.5.

What was New in Version 1.4

■ UNIX Support
The Natural Screen Tester server now runs under UNIX.

■ Gradle Support
The usability of the integrationwith build servers has been improved: a Gradle build file is built
by default.

■ Other
Various other general usability improvements and bug fixing.

What was New in Version 1.3

■ Managing Test Data
An editor is provided to manage test data. You can clone a data file, then execute the test case.
The assertions that are generated can be modified to cover different scenarios. See Managing
Test Data under Designing and Developing a Test Case.

■ Mapping Multiple Dynamic Fields
With the new field type 'Multiple Dynamic Field' you can now capture all field instances with
the same name in a screen. SeeMappingMultipleDynamic Fields underDesigning andDeveloping
a Test Case > Screens.

Getting Started10
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License Keys

Note: During the installation process, a check is performed that the version of the installed
Natural Screen Tester server matches the version in the license key. If you are logged on to
Software AG's Empower site, you can request a new license key from Software AG Logistic
Service Center (LSC).

Natural Screen Tester can be purchased with one of the following types of licenses (it is possible
to purchase more than one type of license):

■ NSRDV License
Developer license. Licenses are calculated based on number of named users (number of domain
user IDs). When a user connects to a session, the number of open connections is compared with
the maximum number of users defined in the license file. The number of open connections may
not exceed this maximum number.

■ NSRRT License
Runtime license. Support for all features.

To update your license

■ If you wish to change the license key after the installation, locate the license file (<Software
AG Installation>\common\conf) and replace the old license with the new one. Restart the Nat-
ural Screen Tester server and the Software AG Designer.

Hardware Requirements

Server

■ 2 x 3 GHz Intel(R) Xenon(TM) processors.
■ 2GB free disk space.
■ RAM: Natural Screen Tester Server requires 200 MB. Each test project requires additional min-
imum 40 MB (depending on the test project repository size). Host sessions require 1 MB per
session.

■ Network card.

Getting Started12
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Natural Screen Tester Development Workstation

■ 2 GB free disk space (server and development tools).
■ RAM: minimum 4 GB.
■ Network card.

Network

Natural Screen Tester supports working with IPv6 as well as IPv4 when working with Natural
Screen Tester components that use IP addresses.

Software Requirements

Operating Systems and Supported Platforms

For details regarding supported platforms and themost updated information refer to the Software
AG Empower website at https://empower.softwareag.com.

Natural Screen Tester server is Java-based and can run on a Java Virtual Machine 1.8. Natural
Screen Tester can run independently as an independent Java process (this is the default installation),
or as a J2EE application under one of the following application servers:

■ Apache Tomcat 7.0.27, 8.0.18, 8.5, 9
■ Oracle WebLogic 12.1.3
■ WildFly 8, 9, 10 (formerly JBoss)
■ Microsoft IIS 7.5, 8, 8.5, 10
■ WebSphere 9.0.x

13Getting Started
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Before you Begin

Make sure you have the following:

■ License for Natural Screen Tester
■ Software AG Designer
■ Local or remote Natural application to test

See Prerequisites for complete list of system prerequisites.

Glossary of Terms

Assertion
An assertion encapsulates some testable logic specified about a target under test. This can be
an attribute-value pair, for example "firstName":"John", or a true-false statment inserted in
a program where the developer always expects a certain condition, for example
"endOfList":"true". Assertions are stored in the generated JSON file.

Configuration File
Each test project has a configuration file in JSON format. This contains default values for the
packages contained in the test project, for example "hostApplication":"my_Mainframe".

Host
The host containing the application you want to test.

Input
Field identified as input field when the test case is recorded, for example User ID. Inputs are
stored in the generated JSON file.

JSON File
In Natural Screen Tester, a JSON file (JavaScript Object Notation) is generated by the Generate
Unit Test wizard from the test project. It contains inputs and assertions for the unit test as at-
tribute-value pairs. You can copy a generated JSON file and change the inputs and assertions.
The unit test is then run multiple times, once for each JSON file.

Test Case
A test case corresponds to an individual function, for example LoginFlow or GetUserById. It
is the result of the recorded screen flow. From a recorded test case you can generate a unit test.

Test Project
A test project corresponds to the Natural application you want to test. It consists of one or
more test cases.

Getting Started16
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Unit Test
A unit test is generated from a recorded screen flow, for example LoginFlow. A unit test is
generated as a test case to a new test project or added to an existing test project. The unit test
is run from the Java file that is generated in the test project.

Creating your First Unit Test

■ Step 1: Create a New Test Project
■ Step 2: Identify Screens and Fields for your Test Case
■ Step 3: Record your Test Case
■ Step 4: Generate a Unit Test
■ Step 5: Run the Unit Test

Step 1: Create a New Test Project

To create a new test project

1 From the Software AG Designer, open the Natural Screen Tester development environment.

2 Connect to the Natural Screen Tester server by double clicking the server icon. A new dialog
for credentials is opened.

3 In theNatural Screen Tester perspective, create a new test project. SelectScreenTester Server,
and from the context menu chooseNew Test Project.

17Getting Started
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4 Enter a name for your new project, a description and specify the initialization mode. Press
Next. See Test Project Configuration Parameters in the Natural Screen Tester Reference Guide.

5 UnderGeneral Test Project Information, specify your Natural host.

Step 2: Identify Screens and Fields for your Test Case

To identify screens and fields

■ See Screens in the Designing and Developing a Test Case documentation.

Step 3: Record your Test Case

To record your test case

1 Under the Sessions folder, double-click the Default session to start the green screen host
session of the test project. During this session you record the screen flow of the test case.

2 Record the screen flow that covers the test case.

Getting Started18
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3 During recording, mark the fields you want to include as inputs for your test case.

4 During recording, mark the fields you want to include as assertions for your test case.

5 Stop the recording.

6 In the Define Test Case Name screen, enter a name, description and folder where the test
case will be stored.

Step 4: Generate a Unit Test

To generate a unit test

1 Review the test case to make sure the inputs and outputs were recorded correctly. You can
also edit or add logic to the recorded test case to make it more general or specific to suit your
needs.

2 Select the test case and chooseGenerate Unit Test.

The following artifacts are generated:

■ Java project that includes a Java file containing the executable test case
■ JSON configuration file
■ JSON file containing inputs and assertions
■ required binary files that are included in the Java project

Step 5: Run the Unit Test

To run the unit test

■ From the Java perspective, select the generated Java file. From the context menu choose Run
as > JUnit Test.
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6 Architecture

Natural Screen Tester automates the testing of business functions available inside host screens. A
manual test is recorded once, and the results can be modified and duplicated to create a test series
using multiple sets of input data. More sophisticated tests can be created using additional test
procedures that would be difficult to record manually.
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7 Installing Natural Screen Tester from an Image File

To install Natural Screen Tester from an image file

1 Obtain the NSR image file from the FTP site (instructions are provided in the email).

2 Run the Software AG 10.2 Installer.

3 In the Installer, navigate toAdvanced Options > Images, select the NSR image file and press
OK.
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4 PressNext to start the installation.

5 Provide the installation directory, host name and start menu group in the Directory panel
and pressNext.

6 In the Products panel, choose Typical installations... and checkNatural Screen Tester.
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7 In the License panel, check the checkbox to agree with the license terms and pressNext.

8 In the Configure panel, provide your NSR license, choose whether to install the product as
a service or as a batch file, modify the ports if needed and pressNext.
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9 Confirm to start the product installations.

10 When the products are installed, press Finish.
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SoftwareAGDesigner enables you to create andmaintain awide number of applications, services,
tasks, and other components to implement and execute your solutions in multiple Software AG
products. Natural Screen Tester is one of the features provided by the Designer.

Starting the Natural Screen Tester Designer

From the Startmenu, choose All Programs > Software AG > Tools > Software AG Designer
<version number>.

Alternatively, you can run the Designer from a remote PC (for example: on a Microsoft Windows
operating system) and connect to the server using TCP/IP. When running the Designer from a re-
mote PC, some Designer features may not work, for example opening the file system.

The first time you start the Designer, a Welcome page will be displayed. From this page you can
access the Natural Screen Tester perspective and the help contents. If you close theWelcome page,
and you would like to display the Natural Screen Tester perspective, go toWindow > Open Per-
spective > Other and selectNatural Screen Tester.

If you are not yet familiar with Eclipse, see the Eclipse online help at http://www.eclipse.org/doc-
umentation/, or start the Software AG Designer and then chooseHelp > Help Contents. General
information on Eclipse can then be found underWorkbench User Guide. When working with the
Software AG Designer, the online help also provides help for the currently installed Software AG
products; this can be found under Software AG Designer Guides.

Logging on

Once the Designer is displayed, you will see the available list of servers. Double-click on a server
or select Connect from the right-click context menu. When this is the first time you are logging
on, by default, "Administrator" will be displayed in the User name field. When it is not the first
time you are logging on, Natural Screen Tester Designer will automatically try to connect to the
last server it connected to.

You can select to remember the user password in the Login dialog box. Once this is selected, the
Login dialog box is not shown again. To require entering a password and displaying the Login
dialog box, change the Remember passwords check box inWindow > Preferences > Software
AG > Natural Screen Tester.

Note: The first time theRemember password check box is selected, an Eclipse Secure Storage
message is displayed. Thismessage offers remembering an internal Eclipse password using
a hint, but this is not applicable to the Natural Screen Tester server password, therefore
clickNo.
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Adding a New Server Connection

Additional connections to servers can be added. To add an additional server connection, in the
Servermenu, choose Add Natural Screen Tester Server Connection.... The wizard is displayed.
Enter the name of the server, the relevant address (IPv4 and IPv6 address formats are supported)
and port. Also determine whether the connection will be a secured connection.

See also Configuring the Server.

Designer Layout

■ Menu Bar Commands
■ Natural Screen Tester Explorer
■ Editor
■ Test Project Map
■ Properties
■ Console
■ Error Log
■ Status Bar

By default the layout is as displayed below, but as possible in Eclipse, the layout can be changed.
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Menu Bar Commands

This section describes the commands that are included in the menu bar that specific to Natural
Screen Tester.

■ File Menu
■ Session Menu
■ Entity Menu
■ Test Project Menu
■ Server Menu

File Menu

Creates a new Natural Screen Tester test project.New > Natural Screen Tester Test
Project...

Creates a new Natural Screen Tester host.New > Natural Screen Tester Host...

Creates a new entity from the list of entities.New > Entity

Creates a new display session.New > Session

Enables importing Natural Screen Tester entities or
importing/replacing a Natural Screen Tester test project.

Import....
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Enables exporting Natural Screen Tester entities or test project.Export...

Session Menu

Creates another session with the same definitions as the selected session.Duplicate Session Definition

Connects to the host using the selected session definitions.Connect

Disconnects the session from the host.Disconnect

Entity Menu

Converts a screen to a screen group.Convert > Screen to Screen Group

Converts a screen group to a screen. See also Screens and ScreenGroups
in the Designing and Developing a Test Case documentation

Convert > Screen Group to Screen

Test Project Menu

Opens the test project.Open Test Project

Closes the test project.Close Test Project

Reloads the repository.Reload Test Project

Opens a wizard which enables importing screen maps.Import Host Screen Maps

Displays the Test Project Map view.Show Test Project Map

Opens a wizard which enables to automatically identify
screens.

Automatically Identify Screens/Steps using
Trace Files...

Opens the file system and allows viewing the files in the
relevant folder.

Open in File System

Server Menu

Adds an additional server connection.Add Natural Screen Tester Server
Connection...

Connects to the server.Connect to Server

Disconnects from the server.Disconnect from Server

Reloads the server configuration, i.e. the configuration of all
test projects connected to the server.

Reload
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Natural Screen Tester Explorer

The Natural Screen Tester Explorer consists of:

■ Explorer Toolbar
■ Explorer Tree

Explorer Toolbar

Adds a new server connection.

Connects to the selected server.

Disconnects from the selected server.

Enables finding an entity.

Enables creating new entities in the currently selected test project.

Explorer Tree

Local Natural Screen Tester server

Hosts

<Host name>

<Test project name>

Session (disconnected)

Session (connected)

Repository

Screen

Screen Group

Connection Pool

Connection Information Set

Flow Procedure

Test Case Procedure

Program Procedure

Data Structure

Database Connection

External Web Service
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Editor

The various entity editors are displayed in the editor area: Screen, ScreenGroup, Connection Pool,
Connection Information Set, Test Case Procedure, Procedure Group, Flow Procedure, Program
Procedure, Data Structure, Database Connection and External Web Service.

Test Project Map

The Test Project Map view displays screens through which the user has navigated. Refer to Test
Project Map in the Designing and Developing a Test Case documentation for further details.

Properties

This area displays basic details regarding the object selected in the Natural Screen Tester Explorer
tree. For example, if you select a Server, the Properties area displays a number of parameters such
as the server address, port, state and version; if you select the Repository, or a folder within the
repository, the Properties area displays parameters such as the test project name, a detailed list
of all the entities, and the number of each type of entity.

Console

This area displays the console messages.

Error Log

This area displays the error log.

Status Bar

Name of GCT trace file/test project name.Online/Offline indication

UNKNOWNwhen the screen has not been identified.Screen name

Row and column, and position in the host.Cursor position

Row and column, and position in the host.Mouse position

Starting position of the currently selected area in host units).Selection start
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Starting Natural Screen Tester Server

The Natural Screen Tester server can be started either as a Windows service or using a batch file.

Note: If you run Natural Screen Tester as a service it will, by default, start automatically
when Windows is started.

To start the Natural Screen Tester server as a Windows system service

1 In the installation process, define that Natural Screen Tester server will run as a Windows
system service.

2 Choose Start > Settings >Control Panel > Administrative Tools > Services.

3 Start the Natural Screen Tester Server service.

To start the Natural Screen Tester Server using a batch command file

1 Access the folder <NSR_installation>/bin folder.

2 Double-click startup.bat.

It is possible to configure the server's system properties.

Refer toNatural Screen Tester Server, System Parameters for further details.

Natural Screen Tester Server System Parameters

When running Natural Screen Tester server as a batch file, these parameters can be configured in
the startup.bat batch file/GXNatural Screen TesterService.ini/startup.sh.

DescriptionParameter

The location of the Natural Screen Tester_home directory.com.sabratec.gxhome

The directory of the license file.com.sabratec.license

Put the server icon in the icon tray.com.sabratec.useicon

Natural Screen Tester configuration file name - under the config folder of the
installation.

com.sabratec.conf

The location of gxstartup.prp.com.sabratec.prpfile

Servlet logger.com.sabratec.logger
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The following parameters provide youwith the ability to determine the server's systemproperties.
Define these properties in the \config\gxstartup.prp file. These parameters can be overridden by
parameters defined in the startup.bat batch file/GXNatural Screen TesterService.ini/startup.sh files.

DescriptionParameter

The directory of the license file.com.sabratec.license

Put the server icon in the icon tray.com.sabratec.useicon

Natural Screen Tester configuration file name - under the config folder of the
installation.

com.sabratec.conf

Servlet logger.com.sabratec.logger

Stopping Natural Screen Tester Server

To stop the Natural Screen Tester server, when started as a Windows system service

1 Select Start > Settings >Control Panel > Administrative Tools > Services.

2 Stop the Software AG Natural Screen Tester Serverservice.

To stop the Natural Screen Tester server using a batch command file

1 Access the Natural Screen Tester installation folder.

2 Double-click shutdown.bat.

Connecting to the Server

To connect to the server

1 In the Natural Screen Tester Designer, click Connect to Server on the toolbar, or right-click
on the relevant server and select Connect.

2 When connecting for the first time, ensure that the server address (IPv4 and IPv6 address
formats are supported) and port that are displayed in the pop-up are correct.

3 ClickOK.

4 Type the User name and Password and clickOK.
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To disconnect from the server

■ In the Natural Screen Tester Designer, clickDisconnect from Server on the toolbar, or right-
click on the relevant server and select Connect.

The communication with the server terminates, and the user's details disappear.

Configuring the Server

To update a Server's configuration, open Natural Screen Tester Designer, and either right-click
on the server (in the Natural Screen Tester Explorer) and select Properties, or select Properties
from the Servermenu.

The Server Properties dialog box is displayed.

Edit the dialog box as follows:

■ General
■ License
■ Log
■ Outgoing SMTP Server

General

Non-secured port
Does not require user name and password authentication.

Secured port
The Secured port check box determines whether SSL is used to securely transfer the data
between the client and Natural Screen Tester server.

To change the HTTP port, edit the server.xml and gxconfig.xml files.

Load Natural Screen Tester archive test projects (gxar)
This check box determineswhether to automatically update the test project with new/updated
gxar files. Once selected, Natural Screen Tester searches the host-projects folder looking for
new/updated gxar files.When one is found, it is loaded automatically as a new/updated project.
You must determine how often to search the folder (by default this is set as one minute).

Enable encryption of recorded sessions
Selecting this checkbox, enables encrypting recorded sessions.

Encryption key file
The encryption key enablesNatural Screen Tester to encrypt and decrypt the recorded sessions.
A key is required for each Natural Screen Tester server.
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Note: Refer to Recording Sessions for further details regarding encrypting recorded
sessions.

License

This page provides information regarding the Natural Screen Tester Server license. It includes the
number of users, the number of licenses for each type of license, the expiry date, the platforms
and the special license terms. See License Keys.

Log

The server log can be accessed from the Natural Screen Tester Designer. Refer to Viewing Server
Logs for further details.

Level
The contents of the log file are as detailed as this property defines, where every level includes
the levels above it. For example, the Debug level also logs Normal, Warnings and Errors Only
levels. Available values: "Errors only", "Warnings", "Normal" and "Debug" (by default Normal
is selected).

Log File Name
The log is written to this file.

Open log folder
Enables you to see the list of existing log files.

Max. file size
Starts a new log file after the current file has been filled to the maximum file size.

Save History
Selecting this check box determineswhether backups of old log fileswill be saved, after restart-
ing the server.

The radio button options determine the number of backups saved before overwriting the old
log files. For example: 10 means "save the last 10 log files, in addition to the current one, then
start to overwrite". When selecting All Files, old log files are never deleted. Default value is
"10".
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Outgoing SMTP Server

Server Address
The IP address of the SMTP server.

From address
Mail sent as part of a Procedure, requires using a From address, which is defined in the pro-
cedure. When the From field in the procedure is left empty, the address defined here, in the
Default From address, will be used.

Requires authentication
For security reasons, you may want to require authentication. Enter the Account name and
Password.

Note: Only an Administrator is able to change the server's configuration.

Viewing Server Logs

The Server Log includes information as to the Server's activities and problems. The contents of
the server log file are defined according to the settings configured in the Server Parameter>Log
node. The Server Log can be accessed from Natural Screen Tester Designer.

To View the contents of server log files from within Natural Screen Tester Designer

1 In the Natural Screen Tester Designer, either right-click on a server and select Show Server
Log, or select Show Server Log in the ServerMenu.

2 To view previous log file history select the relevant file from the list of files in the File name
field.

3 Double-click a file's name. A dialog box with the file's contents appears.

4 Click Refresh, or press the F5 key on the keyboard to renew information on the log file
manually.

5 ClickRestart Log to restart the log. The previous data is saved to a file, and a newfile is created.
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